Use Mail Merge To Send Personalized E-Mail Messages To Your E-Mail Address List

Hide All

When you want to send personalized e-mail to recipients in your address list, you can use mail merge to create the e-mail messages. Each message has the same kind of information, yet the content of each message is unique. For example, in e-mail to your customers, each message can be personalized to address each customer by name. The unique information in each message comes from entries in a data file.

Furthermore, with mail merge, each e-mail message is a separate mailing where each recipient is the sole recipient of each message. This is unlike broadcasting an e-mail message to group of recipients or hiding recipients on the blind carbon copy (bcc) line of the message.
 Notes 
· You must have a MAPI-compatible e-mail program installed. The capabilities of Outlook MAPI (Messaging Application Program Interface) make it possible for Microsoft Office Word and Microsoft Office Outlook to share information when sending the merged e-mail. 

· You must use the same versions of Outlook and Word. If you are using Microsoft Office Word 2007, you must also use Microsoft Office Outlook 2007. 

· You cannot add recipients to the Cc (Carbon copy) line. Mail merge provides no way of designating ancillary recipients. Each recipient receives a copy of the message by being addressed on the To line of the message. 
The mail merge process entails the following overall steps:

1. Set up the e-mail message . The main document contains the text and graphics that are the same for each e-mail message. For example, your company logo or the body of the message. 

2. Connect the e-mail message document to your address list. Your address list is the data source that Word uses in the mail merge. It is a file that contains the e-mail addresses where the messages will be sent. 

3. Refine the list of recipients or items. Word generates a message for each e-mail address in address list. If you want to generate messages for only certain e-mail addresses in your address list, you can choose which addresses, or records, to include. 

4. Add placeholders, called mail merge fields, to the e-mail message document. When you perform the mail merge, the mail merge fields are filled with information from your address list. 

5. Preview and complete the merge. You can preview each message before you send the whole set. 

You use commands on the Mailings tab to perform a mail merge.

 Tip   You can also perform a mail merge by using the Mail Merge task pane, which leads you step by step through the process. To use the task pane, in the Start Mail Merge group, on the Mailings tab, click Start Mail Merge, and then click Step by Step Mail Merge Wizard. In Step 1 of the process, under Select document type, click E-mail messages.
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Set up the e-mail message main document

1. Start Word. 

A blank document opens by default. Leave it open. If you close it, the commands in the next step are not available.

2. On the Mailings tab, in the Start Mail Merge group, click Start Mail Merge. 

3. Click E-Mail Messages. 
Resume A Mail Merge
If you need to stop working on a mail merge, you can save the e-mail message main document and resume the merge later. Word retains the data source and field information. If you were using the Mail Merge task pane, Word returns to your place in the task pane when you resume the merge.

1. When you're ready to resume the merge, open the document. 

Word displays a message that asks you to confirm whether you want to open the document, which will run an SQL command.

2. Because this document is connected to a data source and you want to retrieve the data, click Yes. If you were opening a document that you did not realize was connected to a data source, you could click No to prevent potentially malicious access to data. 

The text of the document, along with any fields that you inserted, appears.

3. Click the Mailings tab, and resume your work. 

Connect The E-Mail Message Document To Your Address List
To merge information into your e-mail message main document, you must connect the document to your address list, also known as a data source, or data file. If you don't already have a data file, you can create one during the mail merge process.

 Note   Make sure that your data file includes a column for the e-mail address. You will need that column later in the process.

Choose A Data File
1. On the Mailings tab, in the Start Mail Merge group, click Select Recipients. 
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2. Do one of the following: 

· If you want to use your Contacts list in Outlook, click Select from Outlook Contacts. 
· If you want to use your Contacts list you have ever made in database, click Use Existing List
Refine The List Of Recipients Or Items
When you connect to a certain data file, you might not want to merge information from all the records in that data file into your e-mail message main document. If your data file includes records with no e-mail addresses, omit them from the e-mail merge. Otherwise, Word won't be able to complete the merge process.

To narrow the list of recipients or use a subset of the items in your data file, do the following:

1. On the Mailings tab, in the Start Mail Merge group, click Edit Recipient List. 
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2. In the Mail Merge Recipients dialog box, do any of the following: 

· Select individual records    This method is most useful if your list is short. Select the check boxes next to the recipients you want to include, and clear the check boxes next to the recipients you want to exclude. 

If you know that you want to include only a few records in your merge, you can clear the check box in the header row and then select only those records that you want. Similarly, if you want to include most of the list, select the check box in the header row, and then clear the check boxes for the records that you don't want to include.

· Sort records    Click the column heading of the item that you want to sort by. The list sorts in ascending alphabetical order (from A to Z). Click the column heading again to sort the list in descending alphabetical order (Z to A). 

If you want more complex sorting, click Sort under Refine recipient list and choose your sorting preferences on the Sort Records tab of the Filter and Sort dialog box.

· Filter records    This is useful if the list contains records that you know you don't want to see or include in the merge. After you filter the list, you can use the check boxes to include and exclude records. 

To filter records, do the following:

1. Under Refine recipient list, click Filter. 

2. On the Filter Records tab of the Filter and Sort dialog box, choose the criteria you want to use for the filter. 

3. To refine the filter further, click And or Or and choose more criteria. 

 Note   If you have installed address validation software, you can click Validate addresses in the Mail Merge Recipients dialog box to validate your recipients' addresses.

Add Placeholders, Called Mail Merge Fields, To The E-Mail Message Document
After you connect your e-mail message main document to your address list, you are ready to type the text of the message and add placeholders that indicate where the unique information will appear in each message.

The placeholders, such as address and greeting, are called "mail merge" fields. Fields in Word correspond to the column headings in the data file that you select.
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 Columns in a data file represent categories of information. Fields that you add to the e-mail message main document are placeholders for these categories.
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 Rows in a data file represent records of information. Word generates an e-mail message for each record when you perform a mail merge.



By putting a field in your e-mail message main document, you indicate that you want a certain category of information, such as name or address, to appear in that location.
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 Note   When you insert a mail merge field into the e-mail message main document, the field name is always surrounded by chevrons (« »). These chevrons do not show up in the final e-mail messages. They just help you distinguish the fields in the e-mail message main document from regular text.

What Happens When You Merge
When you merge, information from the first row in the data file replaces the fields in your e-mail message main document to create the first e-mail message. Information from the second row in the data file replaces the fields to create the second e-mail message, and so on.
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Working With Fields: Examples
You can add any column heading from your data file to the e-mail message main document as a field. This gives you flexibility when you design e-mail messages. For example:

· Suppose you are sending e-mail to notify local businesses that they have been selected for inclusion in your annual city guide. If your data file contains a Company column with the name of each business that you want to contact, you can insert the Company field instead of typing the name of each individual company. 

· Imagine that you send quarterly e-mail messages to your customers alerting them to new products and special deals. To personalize those messages for your best customers, you can add a PersonalNote column to your data file where you can type notes such as "Miss Miller, the new widget is exactly what you have been looking for." By placing a PersonalNote field in the main document, you can include those notes at the bottom of certain messages. 

You can combine fields and separate them by punctuation marks. For example, to insert a person's first and last name, you can set up the fields in your e-mail message main document like this:

«First Name» «Last Name»

For things that you use frequently, like address blocks and greeting lines, Word provides composite fields that group a number of fields together. For example:

· The Address Block field is a combination of several fields, including first name, last name, street address, city, and postal code. 
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· The Greeting Line field can include one or more name fields, depending on your chosen salutation. 

You can customize the content in each of these composite fields. For example, in the address, you may want to select a formal name format (Mr. Joshua Randall Jr.). In the greeting, you may want to use "To" instead of "Dear."

Map Mail Merge Fields To Your Data File
To make sure that Word can find a column in your data file that corresponds to every address or greeting element, you may need to map the mail merge fields in Word to the columns in your data file.

To map the fields, click Match Fields in the Write & Insert Fields group of the Mailings tab. 
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The Match Fields dialog box opens.
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The elements of an address and greeting are listed on the left. Column headings from your data file are listed on the right.

Word searches for the column that matches each element. In the illustration, Word automatically matched the data file's Surname column to Last Name. But Word was unable to match other elements. From this data file, for example, Word can't match First Name.

In the list on the right, you can select the column from your data file that matches the element on the left. In the illustration, the Name column now matches First Name. It's okay that Courtesy Title, Unique Identifier, and Middle Name are not matched. Your e-mail merge message doesn't need to use every field. If you add a field that does not contain data from your data file, it will appear in the merged document as an empty placeholder — usually a blank line or a hidden field.
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Type Content And Add Fields
1. In the e-mail message main document, click where you want to insert the field. 

2. Use the Write & Insert Fields group on the Mailings tab. 
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3. Add any of the following: 

Greeting Line
1. Click Greeting line. 

2. Select the greeting line format, which includes the salutation, name format, and following punctuation. 

3. Select the text that you want to appear in cases where Word can't interpret the recipient's name, for example, when the data source contains no first or last name for a recipient, but only a company name. 

4. Click OK. 

5. If the Match Fields dialog box appears, Word may have been unable to find some of the information that it needs for the greeting line. Click the arrow next to (not matched), and then select the field from your data source that corresponds to the field that is required for the mail merge. 

Individual Fields

You can insert information from individual fields, such as first name, telephone number, or the amount of a contribution from a list of donors. To quickly add a field from your data file to the e-mail message main document, click the arrow next to  Insert Merge Field, and then click the field name.

For more options with inserting individual fields in the document, do the following:

1. On the Mailings tab, in the Write & Insert Fields group, click Insert Merge Field. 

2. In the Insert Merge Field dialog box, do one of the following: 

· To select address fields that will automatically correspond to fields in your data source, even if the data source's fields don't have the same name as your fields, click Address Fields. 

· To select fields that always take data directly from a column in your data file, click Database Fields. 

3. In the Fields box, click the field you want. 

4. Click Insert, and then click Close. 

5. If the Match Fields dialog box appears, Word may have been unable to find some of the information it needs to insert the field. Click the arrow next to (not matched), and then select the field from your data source that corresponds to the field required for the mail merge. 

 Note   If you insert a field from the Database Fields list and then later switch to a data source that doesn't have a column with the same name, Word won't be able to insert that field information into the merged document.


Custom fields from Outlook contacts

The only way to include custom contact fields in your main document is to start the mail merge from within Outlook. First, set up a view of your contacts with the fields that you want to use in the merge, and then start the mail merge. After you choose the settings that you want, Word will automatically open and you can complete the merge.
      Set Up A View Of Your Contacts That Includes Custom Fields
1. In Outlook Contacts, on the View menu, point to Current View, and then click Phone List. 

2. Right-click a column heading, and then click Field Chooser. 

3. In the drop-down list at the top of the Field Chooser dialog box, select User-defined fields in folder. 

4. Drag the field that you to add from the dialog box to the column headings. A little red arrow helps you place the field in the location that you want.
5. 
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 Note   You can add a new field in the Field Chooser dialog box by clicking New at the bottom.

5. After you add all of your custom fields to the view, close the Field Chooser dialog box. 

6. To remove a field that you do not want included in the mail merge, click the field name in the column heading in Phone List view, and drag it off of the column heading. 
Run Mail Merge From Outlook

1. In Outlook Contacts, select individual contacts by pressing SHIFT and clicking to select a range, or by pressing CTRL and clicking to select individuals. If you want to include all the contacts currently visible in the view, do not click on any contacts. 

2. On the Tools menu, click Mail Merge. 

3. If you have selected individual contacts to include in the merge, click Only selected contacts. If you want to include all the contacts currently visible in the view, click All contacts in current view. 

4. If you have configured the Phone List view so that it displays exactly the fields you want to use in the merge, click Contact fields in current view. Otherwise, click All contact fields to make all of the contact fields available in the merge. 

5. If you want to generate a new main document for the merge, click New document. Otherwise, click Existing document, and click Browse to locate the document to use as the main document. 

6. If you want to save the contacts and fields that you have selected, so that they can be reused, select the Permanent file check box, and then click Browse to save the file. The data is saved in a Word document as comma-delimited data. 

7. Select E-mail. 

8. Click OK. When the document opens in Word, on the Mailings tab in the Write & Insert Fields group, click the arrow next to Insert Merge Field, and then click the fields that you want to the e-mail message main document. 

9. When you are ready to complete the merge, on the Mailings tab in the Finish group, click Finish & Merge, and then click Send E-mail Messages. The Subject line is filled with the text you typed in the Mail Merge Contacts dialog box in Outlook. 
 Notes 
· You can't type merge field characters («« »») manually or use the Symbol command on the Insert menu. You must mail merge. 

· If the merge fields appear inside braces, such as { MERGEFIELD City }, then Word is displaying field codes (field code: Placeholder text that shows where specified information from your data source will appear; the elements in a field that generate a field's result. The field code includes the field characters, field type, and instructions.) instead of field results (field results: Text or graphics inserted in a document when Microsoft Word carries out a field's instructions. When you print the document or hide field codes, the field results replace the field codes.). This doesn't affect the merge, but if you want to display the results instead, right-click the field code, and then click Toggle Field Codes on the shortcut menu. 

Format Merged Data
Database and spreadsheet programs, such as Access and Excel, store the information that you type in cells as raw data. Formatting that you apply in Access or Excel, such as fonts and colors, isn't stored with the raw data. When you merge information from a data file into a Word document, you are merging the raw data without the applied formatting. 

To format the data in the document, select the mail merge field, and then format it, just as you would format any text. Make sure that the selection includes the chevrons (« ») that surround the field.

Preview And Complete The Merge
After you add fields to your e-mail message main document, you are ready to preview the merge results. When you are satisfied with the preview, you can complete the merge.

Preview The Merge
You can preview your e-mail messages and make changes before you actually complete the merge.

To preview, do any of the following in the Preview Results group of the Mailings tab:
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· Click Preview Results. 

· Page through each e-mail message by using the Next Record and Previous Record buttons in the Preview Results group. 

· Preview a specific document by clicking Find Recipient. 
 Note   Click Edit Recipient List in the Start Mail Merge group on the Mailings tab to open the Mail Merge Recipients dialog box, where you can filter the list or clear recipients if you see records that you don't want to include.
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Complete The Merge
If you think you will want to reuse the e-mail message main document, you can save it before sending the final e-mail messages.
Save The E-Mail Message Main Document
Remember that e-mail messages that you send are separate from the e-mail message main document. It's a good idea to save the e-mail message main document itself if you plan to use it for another mail merge.

When you save the e-mail message main document, you also save its connection to the data file. The next time you open the e-mail message main document, you're prompted to choose whether you want the information from the data file to be merged again into the e-mail message main document.

· If you click Yes, the document opens with information from the first record merged in. 

· If you click No, the connection between the e-mail message main document and the data file is broken. The e-mail message main document becomes a standard Word document. Fields are replaced with the unique information from the first record. 
Send The E-Mail Messages
1. On the Mailings tab, click Finish & Merge, and then click Send E-mail Messages. 
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2. In the To box, select the name of the field that stores recipients' e-mail address. 

3. In the Subject line box, type a subject line for the message. 

4. In the Mail format box, click HTML or Plain text to send the document as the body of the e-mail message, or click Attachment to send the document as an attachment. 
 Note   If you send the document as a plain text e-mail message, the e-mail message will not include any text formatting or graphics.

[image: image20.png]


[image: image21][image: image22][image: image23][image: image24][image: image25][image: image26][image: image27][image: image28][image: image29][image: image30][image: image31][image: image32]
